
Your Quick Start Guide

Access™ 2007

To start Microsoft® Access 2007, click Start and choose All Programs, Microsoft Office, Microsoft 
Office Access 2007.

Office Button

Provides access to a menu of commonly used commands, such as New, Open, 
Save As, Print, and Close. (This menu replaces the File menu used in previous 
versions of Access.) The right side of the menu contains links to recently 
opened files.

Quick Access toolbar

Contains buttons for frequently used commands (by default, Save, Undo, and Redo). To display a 
commonly used command on the toolbar, click the Quick Access toolbar button  and choose the 
command you want to add.

Ribbon

Contains tabs, which in turn contain groups of related tools, such as buttons, lists, and galleries. A 
gallery is a collection of commands or options that are represented graphically to show their results. 

Navigation Pane

Displays the objects in your database. Objects include tables, forms, queries, and reports. To open an 
object, double-click it. You can expand and collapse the Navigation Pane by clicking the Shutter Bar 
Open/Close button  at the top of the pane.

Database window

Provides a command center for working with database objects. When you open a database object, it will 
appear in the Database window. If you open multiple objects, Access 2007 displays them as a series of 
tabs above the Database window. Click a tab to display that object in the Database window.

Status bar

Tells you the current view. Click the View buttons to switch between views. The View buttons available 
depend on the type of object selected. For example, the View buttons for a table are Datasheet, 
PivotTable®, PivotChart®, and Design .
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2Viewing and Creating Databases

A database is a collection of data or information. A relational database
contains data that is organized into multiple related tables. You create 
relationships between tables by linking one or more fields in one table to 
fields in another table.

Database components

Table: A collection of records and their component fields. Each row is 
called a record; each column is called a field.

Record: A complete set of information about an item in the table. Each 
record is made up of a number of fields.

Field: A specific type of data that applies to each item listed in the 
table. Each column in a table is a field that contains data values.

Data value: An item of data. A data value is the smallest unit of 
information in a database.

Common database objects

OBJECT USED TO…

Table Store data. For example, you can use a table to store 
employee details, such as names and departments.

Query Retrieve specific information—such as which product had 
the highest sales for a given month—from a table.

Form Enter data into a table in a database. You can also use a 
form to view and modify records in a table.

Report Present data in a printed format. You can customize a 
report by applying different font styles and headings.

Macro Automate frequently performed database tasks, such as 
printing a set of weekly reports.

Module Automate and customize database operations. Modules 
are programs written in Visual Basic®.

UNDERSTANDING DATABASE CONCEPTS

Open a database

1. Start Access and do any of the following:

Click the Office Button  and choose Open.

Press c+O.

On the Getting Started screen, in the Open Recent Database pane, 
click the database name or click More to browse for the database.

2. If an Open dialog box appears, specify the name of the folder and 
database you want to open, and then click Open.

Plan a database

Before you create a database, it’s important that you consider the type of 
data to be stored. To plan a database, you must determine:

The purpose of the database

The number of tables you’ll need, and the type of information you’ll 
store in each table

The fields that will be used in each table

The types of queries you’ll want to perform on the database

The forms you’ll need to create

The types of reports you’ll need to generate

Create a database by using a template

1. Start Access and do one of the following:

In the middle pane, under Featured Online 
Templates, select a template.

In the left pane of the Getting Started 
screen, select a template category. Then, 
in the middle pane, select the template 
that most closely describes what you need.

2. In the right pane, enter a name for the 
database. To change the database’s 
location, click the Browse button ,
select a new location, and click OK.

3. Click Create or, if the template is online, click Download.

Create a blank database

When you create a blank database, you start with an empty table named 
Table1, which opens in Datasheet view. You must then manually create the 
objects you want to include in the database. The manual method is more 
flexible because you can create custom tables and fields.

1. Click the Office Button  and choose New.

2. In the middle pane of the Getting Started screen, click Blank 
Database.

3. In the right pane, enter a name for the database. To change the 
database’s location, click , select a new location, and click OK.

4. Click Create.

Name database files and objects

Database and object names can have any combination of letters, numbers, 
special characters, and embedded spaces, with the following exceptions:

Names cannot contain more than 64 characters and cannot start with a 
space.

Names cannot include periods (.), exclamation points (!), accents (`), or 
brackets ( [ ] ).

NOTE: It’s a good idea to use underscores (_) instead of spaces between words.

Save a database so it is compatible with Access 2002 and 2003

By default, Access 2007 creates databases with the extension .accdb. 
Previous versions of Access have used the .mdb extension. Here’s how 
to save a database created in Access 2007 so it is compatible with older 
versions of Access:

1. Click the Office Button .

2. Point to Save As and choose Access 2002-2003 Database.

OPENING, CREAT ING, AND SAVING DATABASES

Change an object’s view

To change an object’s view, open it, and then click the View button 
on the Ribbon and choose the view you want to use. The views 
available depend on the type of object selected.

Datasheet view: View the data in a table, the results of a query, or the 
information on a form. This is the default view when you open a table.

Design view: Change the structure of a table, query, report, form, macro, 
or module.

Form view: View and enter data into a form or subform. This is the 
default view when you open a form.

Report view: View data in a report.

Print Preview: Preview information before printing.

SQL view: View SQL code for a query.

Layout Preview: View a report before printing.

PivotChart view: Display data graphically in Datasheet view.

PivotTable view: Display a table that you can use to analyze data.

Delete an object

Make sure the object is closed. Then, select it in the Navigation Pane and 
press d.

WORKING WITH OBJECTS

Table

Field names

Data values
Record



3Creating Tables and Relationships

Create a table by copying another table’s structure

1. In the Navigation Pane, right-click the table whose structure you want to 
copy and choose Copy.

2. Right-click a blank area in the Navigation Pane and choose Paste.

3. Edit the Table Name field to give the table a new name.

4. Under Paste Options, select Structure Only.

5. Click OK.

Create a table in Design view

1. Click the Create tab. In the Tables group, click Table Design. The 
Table Tools | Design tab appears.

2. For each field you want to create, specify a field name, data type, 
and description.

3. Select the row that you want to define as a primary key and click 
Primary Key on the Table Tools | Design tab. A key icon will appear 
next to the selected row to identify it as the primary key.

4. To apply additional control options, select 
the field and then change its settings on the 
General tab (under Field Properties).

5. Click the Office Button  and choose Save.

6. Enter a name for the table and click OK.

Set multiple primary keys

Open the table in Design view. While holding c, select the rows 
that you want to use as primary keys. On the Table Tools | Design tab, 
click Primary Key.

Data types

The following list describes some of the data types available for fields: 

Text: Stores text or combinations of text and numbers. Text fields can 
store up to 255 characters.

Number: Stores numeric information used in calculations. There are 
several sizes of Number fields, which can store numbers with varying 
degrees of precision.

Date/Time: Stores dates and times, such as 2/3/2000 2:00:00 PM 
and 1/1/2150 5:00:00 PM. Fields of this type accommodate dates and 
times across thousands of years.

Currency: Stores monetary values, such as $5.00. Currency fields can 
store up to 15 digits to the left of the decimal point and 4 digits to the 
right.

Yes/No: Stores one of two values: Yes or No. The size of Yes/No fields is 
controlled by Access.

Memo: Stores lengthy text, such as comments or notes. Memo fields 
can store up to 65,535 characters.

Add fields to a table in Design view

1. In the Field Name column, click an empty cell and enter a name.

2. Press t to move to the Data Type column. Click the 
down-arrow and select the data type you want to use.

3. Press t and enter a description.

4. Press c+S to save the table.

Add fields in Datasheet view

Click in the Add New Field column and enter your data. On the Table 
Tools | Datasheet tab, click Rename. Enter a name for the new field.

Click New Field and drag a field from the Field Templates pane onto the 
table.

CREAT ING TABLES

Primary and foreign keys

A primary key is a field that uniquely identifies 
every record in a table. In the example shown 
here, the Suppliers table has a primary key 
field called SupplierID. If the primary key field 
from a table (for example, SupplierID) appears 
in a second related table (such as the Products 
table), then the field is called a foreign key in 
the second table.

Types of relationships

One-to-one: One record in the primary table is related to only one record 
in a related table, and vice versa.

One-to-many: One record in the primary table is related to several 
records in the related table, while a record in the related table is related 
to only one record in the primary table. This is the most common type of 
relationship.

Many-to-many: Several records in one table are related to several 
records in another table.

Create relationships between tables

1. Click the Database Tools tab.

2. In the Show/Hide group, click Relationships. The Relationship 
Tools | Design tab appears on the Ribbon.

3. Click Show Table to open the Show Table dialog box. Select the 
desired tables, click Add, and click Close.

4. In the Relationships window, drag a field from the first table to a field in 
the second table. The Edit Relationships dialog box appears.

5. Click Join Type to open the Join 
Properties dialog box. Select 
the desired join option and click 
OK.

6. Check Enforce Referential 
Integrity and click Create.

Work with relationships

In the Relationships window, right-click the relationship line connecting two 
tables, and then choose one of the following:

Edit Relationship. Make your 
changes in the Edit Relationships 
dialog box and click OK.

Delete Relationship. Click Yes to 
close the warning message.

CREAT ING TABLE RELAT IONSHIPS

A subdatasheet is a datasheet within another datasheet. It displays a set 
of records from a related table. When you join tables, Access generates 
subdatasheets automatically. If you edit a subdatasheet, all changes will 
automatically be entered in the related table.

Insert a table as a subdatasheet: Open the table where you want to 
insert a subdatasheet and switch to Design view. On the Table 
Tools | Design tab, click Property Sheet. Click the down-arrow for 
the Subdatasheet Name field, and select the name of the table 
that you want to insert.

View a subdatasheet for a record: Click the 
expand indicator  in Datasheet view.

Close a subdatasheet: Click the collapse 
indicator .

USING SUBDATASHEETS

Primary key

Foreign key

One-to-many relationship line

Subdatasheet



4Editing Tables and Using Forms

To modify a field in a table, open the table in Design view and then do any 
of the following:

Select a field: Click the box to the left of 
the Field Name column (the row selector).

Insert a field above an existing field: Select the field that you want to 
insert the new field above. Click the Insert Rows button  on 
the Table Tools | Design tab.

Insert a field at the end of the table: Select the first empty field row and 
enter your information.

Delete a field: Select the field and click the Delete Rows button  
 on the Table Tools | Design tab. If the field contains data or 

is a primary key, click Yes to confirm the deletion.

Move a field: Select the field. Then, click the field’s row selector again, 
but don’t release the mouse button. Drag the field row to its new 
location.

Modify field properties: Select the field. Under Field Properties, on the 
General tab, change the desired settings. Field properties control how 
data is stored and displayed. Some common properties include:

Field Size: Specifies the maximum number 
of characters that can be entered in the 
field.

Input Mask: Specifies the data pattern for 
the field.

Required: Set this property to Yes to 
require that users enter a value in the field.

Smart Tags: Specifies actions—such as 
sending e-mail, scheduling a meeting, or showing the calendar—for 
the data values in the fields.

MODIF Y ING F IELDS IN A TABLE

Add records to a table

There are three ways to add records to a table: 

Click the New button  in the Records group on the Home tab in 
Datasheet view.

Click the New (blank) record button  in the navigation bar at the 
bottom of the Datasheet window.

Click the last row under the first field heading and enter your data.

When you enter data into a record, the record is automatically saved.

Undo changes in a table

If you accidentally delete or modify a record, click the Undo button  on 
the Quick Access toolbar to restore the values.

Enter or edit data in a table or form

Open a table in Datasheet view, or open a form in Form view. Then do any 
of the following:

Enter data in a table: Click a blank field, enter your data, and then press 
t or e to move to the next field.

Enter data in a form: Click the New (blank) record button  in the 
form window’s navigation bar. Click a field, enter your data, and then 
press t or e to move to the next field.

Edit data in a table or form: Use the 
navigation buttons in the table or 
form window to find the record you 
want to edit. Replace field contents 
as needed.

Copy information from the same field in the previous record: Click an 
empty field and press c+’ (apostrophe).

Enter the current date: Press c+; (semi-colon).

Enter the current time: Press c+s+: (colon).

ENTERING AND EDIT ING DATA

Sort records

Sorting is the process of organizing records in a meaningful way so that you 
can retrieve data in an order of your choice. You can sort records manually 
in Datasheet view or Form view. To perform a sort, select the field you 
want to sort by. Then, on the Home tab, in the Sort & Filter group, click 
Ascending  or Descending .

To remove all sorts from a table, click the Clear All Sorts button  in the 
Sort & Filter group.

Filter records

Filtering is the process of temporarily isolating a subset of records that meet 
certain criteria you specify. Open the table in Datasheet view and do any of 
the following:

Filter by selection: Select a whole value or just part 
of a value. Right-click the selection and choose an 
option from the menu.

Filter by excluding a selection: Right-click a value 
that you want to filter out and choose one of the 
Does not <value> menu options.

Filter by form: Filters records based on a specific 
condition. In the Sort & Filter group, click Advanced
and select Filter By Form. A blank form appears. 
Enter criteria in the empty fields.

To remove a filter, click Toggle Filter in the Sort & Filter group.

SORT ING AND F ILTERING RECORDS

Row selector

First record

Record number
Previous record

Last record
First record

New record

Create forms to make entering data easier. A form typically shows just one 
record at a time instead of showing the entire table.

Use the Form Wizard

1. Click the Create tab.

2. In the Forms group, click More Forms and choose Form Wizard.

3. Select a source table and/or query, select the desired fields, and click 
Next.

4. Select a form layout and click Next. Select a form style and click Next.

5. Enter a title for the form, select the desired option for viewing or 
modifying the form’s design, and click Finish.

Use the Blank Form tool

1. On the Create tab, in the Forms group, click Blank Form.

A blank form opens in Layout view, and a Field List pane appears. The 
Form Layout Tools | Format and Arrange tabs appear on the Ribbon.

2. In the Field List pane, click the plus sign (+) next 
to the table that contains the fields you want to 
use on the form.

3. To add a field, double-click it in the Field 
List pane or drag it onto the blank form. (Use 
c+click to select multiple fields.)

4. Use the buttons in the Controls group 
on the Format tab to add a logo, a title, 
page numbers, or the date and time.

5. To use more controls, switch to Design view. Use the tools in the 
Controls group on the Form Design Tools | Design tab. Click the control 
you want to add to the form, and then drag on the design grid to create 
the control.

Work with forms

Add a title to a form: In Design view, click the Form Design Tools | 
Design tab. In the Controls group, click the Title button . Type your 
title in the box that appears in the Form Header section.

Delete a field in Design view: Click the text box for the field and press 
d.

CREAT ING AND MODIF Y ING FORMS



5Creating Queries and Using Forms and Reports

A query is a question you ask about the data stored in a database. In 
response to a query, Access displays the records and fields that answer your 
question.

Create a simple query by using the Query Wizard

1. Click the Create tab. In the Other group, click Query Wizard.

2. Verify that Simple Query Wizard is selected and click OK.

3. Select the source table(s) for the query, 
add the desired fields, and click Next.

4. Specify whether you want the query to 
return detailed data or a summary of the 
data. Click Next.

5. Enter a title for the query, select the desired option for viewing or 
modifying the query’s design, and click Finish.

Create a query in Design view

1. Click the Create tab. In the Other group, click Query Design.

2. On the Tables tab of the Show Table dialog box, select a table. Click Add
and then click Close.

The Database window will have a new tab, with the table you selected at 
the top and a grid at the bottom.

3. In the first cell of the Field row, use the drop-down list 
to select the desired field. The table name will appear 
in the field’s Table cell.

4. Optional: To add a total to a query, click the Totals 
button  on the Query Tools | Design tab. Click a 
Total cell for the field whose data you want to calculate, and choose a 
calculation option (such as Sum) from the list. To remove the Total row, 
click the  button again.

5. Optional: To sort query results, click the Sort cell for the field you want 
to sort by and choose either Ascending or Descending.

6. Optional: To enter criteria for the query, either click the field’s Criteria 
cell and enter the criteria expression (formula), or right-click the cell and 
choose Build to use the Expression Builder.

All criteria entered in the same row are combined together with the 
AND operator. (All conditions must be met.)

Criteria entered in cells in different rows are combined with the OR 
operator. (At least one condition must be met.)

7. To display a field in the query result, check the Show box.

8. Repeat steps 3–7 as needed.

9. In the Results group, click the Run button  to test the query.

To save the query, click the Save button  on the Quick Access toolbar. 
Enter a name for the query and click OK.

CREAT ING AND EDIT ING QUERIES

Add a chart to a form or report

1. Open the form or report in Design view.

2. On the Design tab, click the Insert Chart button .

3. On the form or report, click where you want to place the chart.

4. Complete the steps in the Chart Wizard.

5. Switch to Form or Report view or Print Preview to see the chart with the 
current data.

Add controls to a form or report

When you open a form or report in Design view, the Design tab appears 
on the Ribbon. Use the tools in the Controls group to change the form or 
report’s appearance or functionality. Following are some commonly used 
controls.

ICON NAME USED TO…

Label Name a field or add descriptive text.

Text box Enter data, such as numbers or text.

Option button Select a single option from a set of options.

Check box Select multiple options from a list of options.

Combo box Select an option from a drop-down list.

List box Select multiple options from a list.

Work with controls

Add a control to a form or report: Click the desired control on the Design 
tab. If necessary, drag on the form or report to create the control.

NOTE: Some controls are automatically inserted when clicked.

Select a control: Click the desired control on the form or report.

Move a control: Point to the control you want to move, and when the 
mouse pointer changes to a four-headed arrow , drag the control to its 
new position.

Resize a control: Click the desired control on the form or report. Drag a 
handle  to resize the control.

Anchor a control

You can anchor controls on a form. If a user resizes a form, anchored 
controls will remain in the same location and will resize if necessary.

1. Open the form in Design view or Layout view and select the control that 
you want to anchor.

2. On the Arrange tab, in 
the Size group, click 
Anchoring and select 
the anchoring method.

Modify control or section properties in a form or report

1. In Design view, select either the desired control or the desired section in 
a form or report.

2. On the Design tab, in the Tools 
group, click Property Sheet.

3. In the property sheet, change the 
desired properties.

4. Press c+S to save the changes.

Preview and print

Preview the database object: Open the database object (table, form, 
report, or query). On the Quick Access toolbar, click  and choose Print 
Preview.

Print a table, form, report, or query: Press c+P, select the print 
options you want, and click OK.

WORKING WITH FORMS AND REPORTS

A report presents data in an organized format suitable for viewing on screen 
or printing.

Use the Report Wizard to create a report

1. Click the Create tab. In the Reports group, click .

2. From the Tables/Queries list, select the table on which the report will be 
based.

3. From the Available Fields list, select the fields you want to include in the 
report. Click Next.

4. Complete the remaining steps of the wizard, and click Finish.

View a report

1. Click Reports in the Navigation Pane.

2. Double-click a report to display it in Report view, or right-click the report 
you want and choose Print Preview.

CREAT ING AND VIEWING REPORTS
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6Frequently Asked Questions

Where can I get more help with Access 2007?

Press ! to display Access Help. You can also visit the Office Online Web 
site for further information and resources, such as database templates: 
office.microsoft.com/access.

How do I change the default settings for Datasheet view?

1. Click the Office Button  and click .

2. On the left, click Datasheet.

3. Change the default colors, gridlines, cell effects, font, and font size to 
the settings you want used on all default datasheets.

4. Click OK.

How do I set a default value or validate data for a field?

1. Open the table in Design view.

2. Click the field for which you want to set a default value or validate data. 
Under Field Properties, the field’s general properties appear.

3. To assign a default value, enter it in the Default Value box.

4. To use a validation rule to check data that’s entered into the field, enter 
the desired rule in the Validation Rule box.

5. Press c+S to update the table.

How do I compact and repair an Access file?

To ensure optimal performance, you should compact and repair your Access 
files on a regular basis. If you are compacting a shared Access database, 
make sure that no one else has it open. Then click the Office Button ,
point to Manage, and choose Compact and Repair Database.

What are Key Tips and how do I use them?

1. Press a to display the Key Tip badges. They first appear for all 
Ribbon tabs, the Quick Access toolbar, and the Office Button.

2. Press the key for the desired tab to display all of the Key Tip badges for 
that tab’s buttons.

3. Press the key or keys for the button you want. If the Key Tip is two 
letters, press the first key and then the second one.

What are some common keyboard shortcuts?

KEYBOARD
SHORTCUT USED TO…

@ Switch between edit and navigation modes in a 
datasheet. In edit mode, the cursor is displayed.

% Activate the navigation bar’s record number box.

& Check spelling for the active object.

{ Show or hide the Navigation Pane.

c+o Insert a new record in Datasheet or Form view.

c+- In a datasheet, delete the current record.

c+K Insert a hyperlink in a table, form, or report.

c+h Move to the first field in the first record.

c+n Move to the last field in the last record.

a+e Display a property sheet for a selected table, query, 
form, or report control in Design view.

HELP AND ACCESS OPT IONS

How can I find and replace data in a table?

1. Open the table in Datasheet view and click the Home tab.

2. In the Find group, click Replace to open the Find and Replace dialog 
box, with the Replace tab active.

3. In the Find What box, enter the text or value you want to locate.

4. In the Replace With box, enter the replacement text or value.

5. From the Look In list, select the name of the table. 

6. Click Find Next to begin the search. When the first occurrence is found, 
do one of the following:

Click Find Next to find the next occurrence.

Click Replace to replace the selected occurrence.

Click Replace All to replace all occurrences of the data.

How can I convert a report to a Word document?

1. In the Navigation Pane, right-click the report you want to convert and 
choose Export, Word RTF File.

2. In the Export Wizard, specify the name of the destination file. To open 
the Word document automatically, check Open the destination file after 
the export operation is complete. Click OK.

3. In Word, press c+S to save the document. In Access, click Close
to close the wizard.

How can I import data from an Excel spreadsheet?

1. Open the destination database. Click the External Data tab and click 
Excel.

2. Locate and select the desired worksheet, and click Open.

NOTE: If you see an error message indicating that Access cannot import 
the selected file, open the file in Excel and make sure the data is in tabular 
format.

3. Specify whether you want to import the data as a new table, append a 
copy of the records to the table, or link to the source data. Click OK.

How do I export a table, query, form, or report as an XML file?

1. In the Navigation Pane, right-click the table, query, form, or report you 
want to export and choose Export, XML File.

2. Specify a location and name for the file, and click OK.

3. In the Export XML dialog box, check one or more of the following:

Data (XML): Exports the data to an XML document.

Schema of the data: Exports the schema to an XML file.

Presentation of your data (XSL): Formats your table or query data by 
using an Extensible Stylesheet Language file.

4. Click OK.

Can I add smart tags to a field?

1. Open the table in Design view and select the field.

2. Under Field Properties, click the Smart Tags box, and then click the 
Build button .

3. Check the smart tags you want and click OK.

How do I back up an Access database?

1. Save and close all objects in the database.

2. Click the Office Button , point to Manage, and choose Back Up 
Database.

3. In the Save As dialog box, specify the name and location of the backup 
copy. Click Save.

WORKING MORE EFF ICIENTLY
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